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Chapter 1 System Overview 

Luna Innovations’ Optical Backscatter Reflectometer, model (OBR 5T-50), is a high resolution 

reflectometry device with backscatter-level sensitivity for interrogating optical components or 

modules. The OBR uses swept-wavelength coherent interferometry to measure minute reflections in 
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an optical system. This is reported as reflected amplitude versus time of flight, which scales to 

distance along the fiber with group index. The OBR quickly and accurately locates and measures 

return loss (RL) and insertion loss (IL) events inside an optical path.  A gas cell is referenced on 

each scan, ensuring both length and spectral accuracy. 

 

Figure 1-1  OBR measurement system.  The OBR is a high resolution reflectometer designed for interrogating optical components and 
modules. 
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The Control Software 

The OBR control software includes an intuitive graphical interface. All controls, options, and 

measurement results are easily accessible from a single window. A table of reflection events 

including their location, RL, and IL, is automatically generated with each scan. A LabVIEW-based 

software development kit is included for development of custom applications (refer page 46).  

The OBR can also be controlled remotely using TCP/IP commands (refer page 58).

Caution 

 

Use of controls or adjustments or performance 

of procedures other than those specified herein 

may result in hazardous laser radiation 

exposure and one or more safety protections 

may be impaired or rendered ineffective.  
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Assembly and Startup 

The Optical Backscatter Reflectometer is shipped with everything needed to conduct device 

characterizations, including the measurement instrument and all supporting hardware, software, 

documentation, and cables. 

Read and follow all assembly and startup instructions before attempting to operate the OBR. 

Warning 

 

The protection provided by the equipment may 

be impaired if the equipment is used in a 

manner not specified by the manufacturer, 

resulting in serious injury or death. 

 

 

     Warning 

            

The power cord is the main disconnect for 

equipment.  If it is necessary to ensure no 

power to unit, remove power cord  
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Components List 

The OBR is shipped with the following items. 

 

Optical Backscatter Reflectometer instrument. 

 

One PCIe  Bus cable to connect the OBR 

instrument to the PC  

 

Three (3) power cords, one (1) for the OBR 

instrument and two (2) more for the PC and 

monitor 
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OBR desktop PC 

 

17-inch flat panel monitor 

 

Monitor-PC interface cable  
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Keyboard 

 

Mouse 

 

Attenuator, polarization controller, and 10dB gold 

reflector 
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Optical fiber connector cleaner 

 
FC/APC bulkhead 

 

Optical fiber bulkhead connector cleaners 
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If components are missing or damaged, contact Luna Innovations toll free at 866-586-2682 or by e-

mail at solutions@lunainc.com. 

Setting up the OBR 

To set up the OBR 

1  Remove all the OBR components from 

the shipping containers and verify that 

no components are missing. (See components list.)  

2  For best performance, place the OBR on  a stable surface, capable of supporting the weight 

of the entire unit. For the weight and 

dimensions of the unit, see Appendix A‚ 

“Specifications”. 

 

3  Unpack and set up the desktop PC. Connect the monitor, keyboard, and mouse to the PC, 

using the cables provided. 

Important 

 

Do not turn on the instrument yet. 

Do not connect the instrument to the PC until instructed. 

Important 

 

The instrument should always be fully 

assembled before turning power on to 

any of its components. 

Important 

 

Place the OBR away from walls or objects 

that will restrict the air flow through the fan 

duct on the back and sides of the unit. 
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4  Connect the OBR instrument to the PC using the PCIe cable.  

5  Optional: To connect the OBR to a network, connect a network cable (not provided) to the 

Ethernet port on the PC. 

6  Attach the power cords provided to the instrument and to the PC. To ensure safe operation, 

position the instrument to allow easy access to the power cord. Note that the OBR requires 

surge-protected, grounded outlets. 

7  Power on the OBR instrument first, and then the PC. 
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Chapter 2 Software Guide  

The control software is the primary interface between the user and the instrument. It provides all of 

the necessary tools to perform precise length, RL and IL measurements of fiber-coupled optical 

devices.  

This chapter provides an overview of the location and function of all controls and indicators included 

in the control software.  Chapter 3‚ “Performing Measurements,” provides greater detail on how to 

use the OBR to perform specific measurements. Chapter 4, “Software Development Kit” assists the 

user with developing their own software to perform OBR tasks. 

Starting the software 

Double Click on the OBR icon on the desktop or select OBR 5T-50\OBR from the start menu.   

The OBR Control main window will open and the instrument will configure.  

If the OBR instrument is not powered on or not connected, the software will offer to start in 
Desktop Analysis Mode. This mode will not allow the user to operate the instrument, but will 

allow saved measurement files to be loaded and analyzed. To enter this mode, Press OK. 
Pressing Cancel will cause the software to exit. 
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Window Features 

 

 

Figure 2-2 OBR Control window is the main user interface 

 

The main OBR Control window is composed of four (4) functional areas: 
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1 The System Control area contains buttons to control the OBR and save files 

2 The Graph area displays time domain data with respect to a length axis as selected from the 

drop down menu. Buttons to the lower left of the graph adjust plot axes, cursors, and zoom 

3 The Results area displays a table of reflection events and corresponding return loss and insertion 

loss 

4 The Menu Bar contains commands for loading and saving data and event files, as well as for 

setting various measurement and display options 

System Control 

The System Control area allows users to control measurement operations. 
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Figure 2-1 System Control area 

1 Acquire – clicking on this results in a single measurement scan being displayed in the Graph.  

Checking Continuous results in a continuously updated display of the attached device. 

Checking Enable Averaging results in the display of the averaged amplitude over the user-

selected number of scans. 

2 Save File – clicking on this saves measurement data in the form of a binary data file (of type 

“.obr2”). It is not possible to save binary data when Enable Averaging is checked, because 

averaging of amplitude data results in a loss of information regarding S and P components. 

Thus Save File is greyed out. 
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Graph 

The Graph area displays time domain amplitude data in dB. This data is either newly scanned or 

loaded data. 

 
 
 

     
 
 

Figure 2-2 Graph area 

 

1 Length menu – The pull-down menu at the bottom of the time domain graph allows the user 

to select the value and units of the X-Axis: Time (ns), Length (m), Length (ft), Length 

(in), or Length (mm).  
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Figure 2-3 Parameters menu 

2 Buttons to the lower left of the graph allow the user to adjust plot axes, cursors, and zoom, 

and to save graph or screen. 

Scaling Plot Axes 

The OBR control software provides several ways for adjusting the scaling of the graph 

windows. 

 Autoscaling 

The user may rescale each plot axis independently by using the buttons for the X-axis  and 

the Y-axis . 
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 Manual scaling 

The plot axes may be scaled manually by double-clicking on either the lowest or highest value 

labeled on the axes and typing in a new value. To accept the new value, press enter or click 

anywhere in the screen. 

Note that by using this method it is possible to flip the graph so that increasing values on the 

X-axis run from right to left, and increasing values on the Y-axis run from top to bottom.  

Cursors 

The OBR control software offers three types of cursors. By default, vertical cursors and twin 

locked cursors appear at 10% and 90% of the X-axis range. Horizontal cursors appear at 10% 

and 90% of the Y-axis range. To move the cursors, select the cross-hair,  then click, drag, 

and release the cursor. 

 Vertical Cursors:  

Clicking this button toggles two vertical cursors on and off. Note that when these cursors are 

on, the location of these cursors are highlighted in contrasting colors, and the results are 

displayed in the upper right legend.  

 Horizontal Cursors:  

Clicking this button toggles two horizontal cursors on or off. 
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 Twin Locked Cursors:  

Clicking this button toggles twin locked cursors on and off. Regardless of where these cursors 

are dragged, they will intersect the graph at a data point on the displayed trace.  

Using Zoom Tools 

There are six available zoom tools, which are accessible by 

clicking the zoom menu button .  When this button is 

clicked, a pop-up window containing the six zoom tools opens.  

A blue border surrounds the selected tool. 

 The zoom window tool:    

This tool allows the user to zoom in on a rectangular region of the graph window.  To use this 

tool, first select it from the zoom menu button. Then click in the graph window and hold the 

mouse button to define one corner of the rectangular region. Then drag the mouse cursor and 

note that a dotted box appears with corners defined by the original click position and the 

current mouse cursor position. Drag the box around the desired region of the graph window 

and release the mouse button. Both the X- and Y-axis scales adjust so that the selected region 

fills the entire graph window. 
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 The X-axis zoom tool:    

This tool allows the user to zoom in on a region of the X-axis only, without adjusting the Y-

axis scale.  To use this tool, first select it from the zoom menu button. Then click in the graph 

window and hold the mouse button to define one edge of the desired X-axis region. Drag the 

mouse cursor to the other edge of the desired region and note that a fixed vertical dotted line 

appears where the original click occurred, and another follows the mouse cursor. When the 

cursor is positioned at the other edge of the desired region, release the mouse button. The X-

axis scale adjusts to show only the selected region. 

 The Y-axis zoom tool:    

This tool allows the user to zoom in on a region of the Y-axis only, without adjusting the X-

axis scale.  To use this tool, first select it from the zoom menu button. Then click in the graph 

window and hold the mouse button to define one edge of the desired Y-axis region. Drag the 

mouse cursor to the other edge of the desired region, and note that a fixed horizontal dotted 

line appears where the original click occurred, and another follows the mouse cursor. When 

the cursor is positioned at the other edge of the desired region, release the mouse button. The 

Y-axis scale adjusts to show only the selected region. 

 The return to full zoom tool:    

Selecting this button from the zoom menu returns the graph to the full scale of all data. 
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 The zoom in tool:    

This tool allows the user to zoom in (magnify) the graph from the point where the cursor is 

clicked.  To use this tool, first select it from the zoom menu button. Then click once to magnify 

once; or click, hold and release to magnify several times at the cursor location. 

 The zoom out tool:    

This tool allows the user to zoom out from the point where the cursor is clicked.  To use this 

tool, first select it from the zoom menu button. Then click once to zoom out once; or click, 

hold and release to zoom out several times at the cursor location. 

 The pan tool:     

This tool allows the user to click in the graph window and drag the data to the left or right.  To 

use this tool, first select it from the zoom menu button. Then click and hold the click in the 

graph area.  Scroll the mouse left or right to move the data. 

 

 Save Graph Tool:    

This tool allows use to save the current graph as a .jpg image file. 
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 Save Screen Tool:    

This tool allows use to save the current screen as a .jpg image file. 

 

 Show/Hide Cursor to Event Buttons Tool:    

Pressing this button will show (or hide) the event buttons in the Results area; the buttons 

provide user a convenient way to move the vertical cursor to the measurement location 

relevant to the event. 

 

 Move Cursor to Peak Tool:   

Pressing this button will move the vertical cursor to the highest nearby measurement point. 
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Results 

The Results area displays a table of reflection events and their corresponding location, return loss, 

and insertion loss values.  The area also can display the Cursor to Event Buttons (Buttons can be 

either shown or hidden via the “Show/Hide Cursor to Event Buttons Tool”); by pressing one of the 

buttons, vertical cursor will move to the event’s relevant measurement location in the graph. 
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Figure 2-4 Results area 

 

1 Save Event File – clicking on this saves the results in the table in a tab-delimited .txt file. 

Menu Bar 

The OBR control menu bar contains three (3) items. 

1 The File menu: 

1.1 Load File loads a binary data file (of type “.obr2”) previously saved by the OBR. A 

dialog box appears allowing the user to select the file 

1.2 Save File saves measurement data in the form of a binary data file (of type “.obr2”) 

1.3 Save Text File saves measurement data in the form of a tab-delimited data file (of type 

“.txt”) containing length and amplitude information  

1.4 Save Event File saves the location (units as selected by user from the pull-down menu 

at the bottom of the time domain graph), return loss (dB), and insertion loss (dB), of 

the selected number of events as displayed in the Results area 

1.5 Streaming Data File Settings allows the user to configure streaming data files. These 

are tab-delimited text files that are appended with graph or results table data with each 

measurement that is acquired during Continuous mode. 

1.6 Exit exits the OBR control software 



 OBR Users Guide 

  

 

29 
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2 The Tools menu:   

2.1 Set Preferences allows users to control measurement and display options 
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Figure 2-5 Set Preferences dialog box 

 

2.1.1 Integration Widths set the length of segments about each identified reflection 

event, which are used to calculate the Return Loss and Insertion Loss of 

these segments. The units for these widths depend on the units selected by the 

user from the drop-down menu  

 

2.1.2 Display Options allows the user to select the following display options: 

 Autoscale X-Axis –automatically scales the X-Axis to the maximum 

measured range when checked 

 Autoscale Y-Axis – automatically scales the Y-Axis to the maximum 

measured range when checked 

 Apply Hanning Window – turns on the Hanning Window when checked 

(see “Hanning Windowing” on page 92)  
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 # Pts in Graph – allows the user to set the decimation factor for data 

viewing 

 Zero length location – allows the user to shift the x-axis zero location.  

This applies to the graph, event table and text file however, the binary 

data file remains unchanged. 

2.1.3 Events allows the user to select the following event options: 

 Maximum # Events (1-4) – number of event to display 

 Minimum location – location at which to begin event search 

 Maximum location – location at which to stop event search  

 Minimum threshold (dB) - locations with amplitude higher than this 

threshold will be recognized as an event. The user should always view the 

undecimated data (524288 pts) when determining a suitable event 

threshold, as decimated data reduces peak maxima. 

 Maximum IL threshold (dB) – threshold for identifying insertion loss 

events 

 Sort by – whether events are sorted by location, return loss, or insertion 

loss 
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 Event search type – whether return loss events, insertion loss events, or 

both should be displayed in the results table 

2.1.4 Fiber Settings allows the user to enter the Group Index appropriate for the 

device under test 

2.1.5 Software Settings  

 Align on startup - allows the user to check the alignment of the OBR’s 

optics on software startup. Note also that the alignment is automatically 

checked prior to calibration. 

 Require password to change preferences – allows the user specify a 

password that must be entered to modify the preferences shown on this 

screen 

 Save will store the specified settings for use during subsequent executions of the software 

 Apply & Close will use the specified settings without storing them 

 Cancel exits the Set Preferences window without changing any parameters 

 

2.2 Align performs an alignment of the internal optics of the OBR. See “Aligning the 

 Optics” on page 38 for more information about system alignment.  
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2.3 Calibrate calls up a dialog box which queries the user on a previous alignment of the 

 optics before running a calibration. (See “Calibrating the System” on page 39 for complete 

 calibration instructions.) 

 

3 The Help menu – provides User Guide, What’s New notes, and general information on the OBR 

including the software and firmware versions. 
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Chapter 3 Performing Measurements  

Instrument Setup 

The front panel of the Optical Backscatter Reflectometer contains the power switch and the optical 

connectors necessary to perform measurements. 
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Figure 3-1 The OBR instrument 

Four LEDs indicate the state of the instrument: 

•  The Power LED lights when the power is on. 

•  Source LED lights after the laser has been turned on. 

•  Ready  LED lights when the instrument is ready to take a measurement  

•  Transmit LED lights at fixed pulse rate indicating instrument is scanning at all times 

Start the control software by double-clicking the desktop icon, or by selecting OBR 

Software from the programs group in the Windows® Start menu. The OBR window will 

appear. The instrument will take a few moments to initialize before it is ready to use.  

Aligning The Optics 

In order to perform accurate measurements, the internal optics of the OBR must be properly 

aligned.  The alignment is checked automatically prior to calibration.  The two conditions that 

require an alignment to be performed are listed below. 

Alignment must be performed… 

1 When the instrument is initially set up for the first time 

2 Whenever the OBR is physically moved from one location to another 
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To align the OBR optics 

1 Ensure that the OBR unit is powered on and that the laser is on and ready 

2 Select Tools > Align Optics 

A dialog box appears instructing the user to disconnect devices. The user may opt to Cancel or click 

OK to continue. 

If OK is selected, alignment begins. When the alignment is complete, a dialog box informs the user 

of the success of alignment. Selecting OK returns the user to the software control window.  

3 The user must next perform a calibration, as described below. 

Calibrating the System 

The OBR must be calibrated prior to performing measurements. The OBR calibration removes the 

effects of the measurement network to ensure that the measured data represent only the device 

under test. 

Conditions that Require Calibration 

In a typical laboratory or manufacturing environment, calibration should be performed at least once 

every 24 hours. The need to recalibrate is largely determined by the surrounding environmental 

conditions. If the temperature is fluctuating rapidly, it may be necessary to calibrate more than 

every 24 hours. If the surrounding temperature is very stable, a longer interval may suffice. 
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Calibration should be performed whenever the surrounding temperature has changed by more than 

5± degrees C. And as previously mentioned, the OBR must be calibrated after an alignment. 

The Calibration Procedure 

 

 

 

 

1 Ensure that the OBR unit is powered on. The Ready light on the front of the instrument comes 

on when the laser is ready. 

2 Select Tools > Calibrate. 

3 A prompt appears instructing the user to disconnect all devices from the OBR.  This is necessary 

to allow the instrument to check the alignment prior to calibration. 

4 When the alignment succeeds, a prompt appears instructing the user to connect the supplied 

attenuator, polarization controller, and 10dB gold reflector to the instrument. 

Important 

 

During the calibration procedure, ensure the 

supplied calibration artifacts are on a stable 

surface, free from motion and vibration. 
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5 Align the connector key to fit in the groove in the bulkhead adaptor. Turn the screw ring around 

the connector clockwise until it is just tightened. 

6 Click OK. Adjust the Polarization Controller Paddles per the instructions prompted in the software. 

7 A prompt appears instructing the user to disconnect the reference fiber and reflector. After doing 

so, click OK. 

8 Click OK in the dialog box indicating that the instrument has been successfully calibrated. 

Acquiring Data 

The OBR has several options for data acquisition: Single Scan Mode and Continuous Scan Mode.  

Single Scan Mode  

To perform a single-scan measurement: 

1 Ensure that the OBR unit is powered on and that the laser is on and ready. The Ready light 

comes on when the software is launched 

Important 

 

Before attaching any fiber, clean the fiber optic 

connector with the appropriate cleaner to 

guard against errors or equipment damage. 

For instructions, see “Cleaning Connectors” in 

the Maintenance Chapter 
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2 Be sure that the instrument has been aligned (see “To align the OBR optics” on page 38), and 

calibrated (see “To calibrate the system” on page 39) within the recommended time period 

3 Before connecting the device to the OBR, be sure to clean all fiber optic connectors. (See 

“Cleaning Connectors” on page 95.) 

4 Connect the device to the Source port on the front of the OBR 

5 Click Acquire in the System Control area (Fig 3-2) 

The instrument performs the measurement and the software displays the test data in the graph. 

6 The Results table will be populated by the Location of reflection events as well as Return Loss 

and Insertion Loss values. The number of reflection events is a user-defined value (maximum 

4) that is set in Tools > Set Preferences. The Minimum location that the user wants the 

software to display reflection events for is also set in this dialog box. 

Continuous Scan Mode 

Continuous scan mode takes advantage of the fast measurement speed of the OBR to monitor 

devices whose properties may change over time. 

 

1 Perform all but the last step of the Single Scan mode above. Before clicking the Scan button, 

check Continuous in the System Control area of the main window 

2 Click Scan in the System Control area (Fig 3-2) 
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3 The Acquire button will turn gray during continuous scanning 

The active graph window(s) will update after each scan. 

4 The Results table will update continuously after each scan  

5 To stop scanning, either click the grayed Acquire button again, or uncheck the Continuous box 

above the Acquire button  

Saving Data Files 

The OBR control software provides two options for saving data files. The first file type (.obr2) is a 

binary data format that completely captures the measured data and stores it in a format that can be 

loaded back into the control software at a later time for further analysis.  This data file can also be 

loaded into the OBR 5T-50 Advanced Analysis Software for a more feature rich analysis 

environment.  Contact Luna Innovations for more information on this software package. 

The second file type is a text file in a tab-delimited spreadsheet format. Text files contain the 

amplitude data displayed in the graph at the time of saving. Data saved in the spreadsheet format 

cannot be loaded back into the control software. 

It is highly recommended that the binary data format be chosen over the spreadsheet format for 

data archives. The binary format stores the complex polarization diverse spectral reflectivity, 

whereas the spreadsheet format stores only the polarization averaged amplitude (Reflectivity). 

Furthermore, a spreadsheet file can always be generated from a binary file at a later date, but a 

binary file cannot be generated from a spreadsheet file. Finally, other data analysis software 
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packages available from Luna Innovations accept only the binary data format produced by the OBR 

control software. 

The option to save binary data is available through either the Save File button in the System 

Control area, or through File > Save File. 

The option to save a text file is available through File > Save Text File. 

If the user is in Continuous Measurement mode, the file saved will contain data from the scan 

taken just before the user clicked OK. 

 

 

 

 

Spreadsheet File Data 

The header of a spreadsheet file gives the following information: 

 Instrument used 

 Date and time (GMT) data was acquired 

 Date and time (GMT) of last calibration 

 Group Index value used for calculations 

Important 

 

When File > Save File is selected, or when the 

Save File button is clicked, the OBR software 

will overwrite any files with the filename 

specified, without warning the user. 
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Parameter measured and units are given at the top of each column. 

Saving Event Files 

Reflection events as displayed in the Results area can be saved into a tab-delimited spreadsheet 

format. The option to save reflection events is available through either the Save Event File button 

in the Results area, or through File > Save Event File. If the user is in Continuous 

Measurement mode, the file saved will contain data from the scan taken just before the user 

clicked OK. 

Event File Data 

The header of an event file gives the following information: 

 Instrument used 

 Date and time (GMT) data was acquired 

 Date and time (GMT) of last calibration 

 Group Index value used for calculations 

Parameter measured and units are given at the top of each column. 
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Saving Streaming Data Files 

Data from the graph and event table can be streamed into a tab-delimited text file, suitable to be 

processed by a user-developed program or loaded into a spreadsheet program. 

The Steaming Data Files Settings are available from the program menu. 
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Separate text files can be enabled to hold the graph data or the event table data. The Data File Base 

Name and Folder options control the location and filename of the created files. The actual filename 

will also be appended with a date and timestamp. The Maximum File Size can be set to prevent a file 
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from becoming larger than desired. If the size is set to a non-zero number, the data file will stop 

adding data to the file once that size has been reached. 

Once a streaming data file has been configured, data will be added to it each time the graph or 

event table is updated while the software is operating in Continuous mode. The results of single, 

non-continuous scans are not appended to the data file. 

The format of the graph data text file is shown below. 

 

The first row of data contains the x-axis for the graph, using the same units selected in the 

software. All subsequent rows show a timestamp in the first column, followed by the measurement 

value for each x-axis point. There will be one measurement row for each scan taken during 

continuous mode operation. Each row is on a separate line. Columns are separated by tab 

characters. 

The format of the table data file is similar. 
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The file contains multiple rows for each measurement taken during continuous mode. Each row 

contains the details for a single event from the Results table. The maximum number of events can 

be configured from the Tools, Set Preferences… option in the program menu. This also controls the 

number of event rows per measurement that the table data file contains. The timestamp field can be 

used to group events as belonging to the same measurement, and also to correlate events in the 

table data file to measurement data in the data file. 

The columns of the event rows show a timestamp followed by the event number, location, interval, 

return loss, and insertion loss. Columns are all separated by a single tab character. Note that, 

depending on the tab width settings of your file viewer, the event columns may not align with the 

column headers. However, the tab delimiters will allow the columns to be correctly parsed and 

interpreted by a spreadsheet program. 
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Graph data file loaded into a spreadsheet 
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Table data file loaded into a spreadsheet 

Loading Data Files 

Only data saved in the binary format (.obr2) can be loaded into the control software.  

1 Select File > Load File from the pull-down menu 

2 In the dialog box that appears, choose the desired file and click OK 

The loaded data will appear in the graph area, and the Results table will auto-update to display 

reflection events identified within the newly loaded data  
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Chapter 4 Software Development Kit  

Overview 

The OBR Software Development Kit (SDK) is a collection of software routines that allows users of 

Luna Innovations’ OBR to develop custom software utilities targeted for a specific measurement 

application. By utilizing the SDK software package, OBR users have the ability to write custom 

graphical user interfaces and data analysis packages using the same source code used to develop 

the instrument operational software. 

The SDK includes sample code in C++ and LabVIEW. The example programs were written and 

tested using Visual Studio 2012 and LabVIEW 2012. 

The SDK functions are contained in DLLs (primarily Caerus.DLL) to control the OBR and to perform 

calculation. It may be possible to call these same DLL functions from other programming languages; 

however C++ and LabVIEW are the only languages currently supported by the SDK. 
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Getting Started 

Copying SDK files 

The SDK consists of a set of directories and files, which should be copied to a directory on your PC. 

For the sake of clarity, it is recommended that the software be copied to the folder 

C:\OBR5T50_SDK.  They can be placed in an alternate path if desired, but the remainder of these 

instructions will assume that you have used the default name. 

The SDK contains the following folders: 

bin – contains the necessary DLLs for linking against the OBR SDK 

C++ – contains a C++ example Visual Studio project demonstrated the key capabilities of the 

SDK 

LabVIEW – includes LabVIEW VIs demonstrating the key capabilities of the SDK 

setup – contains installers for Microsoft runtime components that are required by the SDK 

DLLs 

Note that the C++ and LabVIEW examples are configured to link to the DLLs in the bin folder. Any 

programs created using the SDK should include the files in the bin folder as part of their 

redistribution package. 
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Runtime installer 

The SDK DLLs require that the Microsoft C++ Runtime Library be installed on your computer. To 

install this, run the file finishInstallCaerus.bat from the Setup folder. If the computer running the 

SDK already has the OBR software installed, this step should be unnecessary. 

Using the OBR SDK 
 

The easiest way to begin using the SDK is to run the provided example programs. These programs 

demonstrate the various operations that can be performed with the SDK, and can serve as starting 

templates for writing your own programs. 

LabVIEW Support 

Low Level VIs and Example Programs 

The LabVIEW LLB Caerus.llb contains low level VIs that call the DLLs in the SDK’s lib folder. These 

VIs serve as building blocks for writing more complex programs. 

The remaining files in the LabVIEW folder are examples that demonstrate how to control the OBR to 

perform using the SDK. 

crssdk_example_singlescan.vi 
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Figure 4-1  crssdk_example_singlescan.vi Front Panel 

crssdk_example_singlescan.vi demonstrates the minimum steps that must be done to initialize the 

OBR, acquire a measurement, and display data. If you have an OBR which has been both aligned 
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and calibrated using the standard OBR software, singlescan.vi is the best place to begin learning the 

SDK. 

When you run singlescan.vi, it will initialize the OBR, take a scan, and display graph data. The VI’s 

block diagram shows steps necessary to perform this measurement.  

 

Figure 4-2  crssdk_example_singlescan.vi 

crssdk_connect.vi connects to the OBR device and initiates scanning. This function must be called 

first before calling any other SDK function. The calibration status of the instrument is available as an 

output. 

crssdk_getAmpSamples.vi determines how many points will be returned for each measurement, and 

how much memory needs to be allocated for the data. crssdk_singleProcess.vi starts the thread that 

processes the raw scanned data into amplitude and event form, while actual data processing is 

carried out in crssdk_getAmpAndEventData.vi.  
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Figure 4-3  crssdk_getAmpAndEventData.vi function block 

crssdk_getAmpAndEventData.vi allows the user to access the amplitude, the S and P polarization 

components of the amplitude, a scaled x-axis, and a list of event locations and magnitudes. If no 

parameters are set, the default OBR preferences are used for this VI. 

crssdk_cleanup.vi closes the connection to the OBR 5T-50 instrument. Important: This function 

must always be called before the program exits and after all other calls to OBR SDK functions have 

been made. Failure to call crssdk_cleanup.vi may cause the program to hang when it attempts to 

exit, and it may be necessary to power cycle of the OBR instrument or the PC before successfully 

connecting to the OBR again. 

crssdk_getError.vi retrieves any error codes and messages from the earlier steps. If no errors 

occurred, the error code will be STATUS_OK and the error message will be blank. 
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The SDK VIs are written to propagate any errors that occur. Therefore it is not necessary to check 

the error status at each step; the program can instead retrieve the error status at the end of a chain 

of operations as shown here. 
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crssdk_example_scanAndDisplay.vi 
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Figure 4-4  crssdk_example_scanAndDisplay.vi Front Panel 

This example demonstrates how to acquire OBR measurements continuously. 

 

Figure 4-5  crssdk_example_scanAndDisplay.vi 

The setup and structure is similar to crssdk_example_singlescan.vi. First, crssdk_connect.vi is called 

to connect to and initialize the OBR.  

crssdk_startProcessing.vi is called instead of crssdk_singleProcess.vi, which was used in the 

previous example. crssdk_startProcessing.vi initiates continuous processing of measurement data 

from the OBR, while crssdk_stopProcessing.vi ends the continuous processing. 
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crssdk_getAmpAndEventData.vi is again called to retrieve the measurement data. This example 

displays a detector saturation indicator, using the saturation output of 

crssdk_getAmpAndEventData.vi. 

As in the previous example, crssdk_cleanup.vi is called to shut down the OBR connection, and 

crssdk_getError.vi is called to display any errors that occurred. 

crssdk_example_saveFile.vi 

 

Figure 4-6  crssdk_example_saveFile.vi 

crssdk_example_saveFile.vi performs the same steps as crssdk_example_singlescan.vi, but also 

calls crssdk_saveFile_OBR2.vi to save the binary measurement file. This example tries to the 

measurement to the filename C:\MyData\example.obr2. This should be changed using the front 

panel path control to a filename and destination folder that can be accessed in the target computer. 
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crssdk_example_loadFile.vi 

 

Figure 4-7  crssdk_example_loadFile.vi 

This example calls crssdk_loadFile_OBR2.vi to load an existing measurement file. As in the file save 

example, the user should use the path control to select a file that exists on the target computer. 

crssdk_example_alignOptics.vi 

 

Figure 4-8  crssdk_example_alignOptics.vi 
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This example demonstrates how to check the OBR alignment and to perform an alignment. 

crssdk_isAligned.vi checks to see whether the OBR is in alignment. If it is not, crssdk_align.vi is 

called to realign the OBR.  

crssdk_example_calibrateInstrument.vi 

 

Figure 4-9  crssdk_example_calibrateInstrument.vi 

 

This example demonstrates how to calibrate the OBR. crssdk_calibrate.vi is called to perform the 

calibration procedure. This VI will display several dialog boxes instructing the user to attach the 

calibration instrument and to move its paddles. 



 OBR Users Guide 

  

 

63 

 

crssdk_example_showError.vi 

 

Figure 4-10  crssdk_example_showError.vi 

This example demonstrates how to retrieve the error status and message from the previous SDK 

operations. This is also shown at the end of the other SDK examples. 

This example tries to connect to the OBR and then shows the any error message that occurs. If 

there is no error, the error code will be STATUS_OK and the error message will be blank. If the SDK 

cannot connect to the OBR (for example, if this program is when with the OBR turned off or 

disconnected from the PC) the program will show the error code STATUS_COMM_ERROR and error 

message, “Communication failure. Please ensure the device is properly connected.” 
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C++ Support 

 

The C++ folder contains an example Visual Studio project that controls the OBR using the SDK. 

The file CaerusSDK.h contains prototypes for all of the functions available in the OBR 5T-50 SDK. 

The file example.cpp demonstrates how to use the SDK functions to connect to the OBR, calibrate 

the system, acquire measurements, and receive graph and event data. 
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Chapter 5 Controlling the OBR Remotely 

This chapter provides information about controlling the OBR remotely by sending text-based remote 

commands using either TCP/IP or GPIB. This section assumes that the user already has some 

familiarity with TCP/IP or GPIB. 

Nearly all functions that can be performed using the graphical interface of the control software can 

also be performed remotely. This includes setting parameters, performing measurements, loading 

and saving data files, as well as receiving data over the remote interface. However, continuous 

mode is not available with remote operation. 

Note: The x-axis and y-axis measurement data may be retrieved using the remote commands. 

However, it can take a long time to transfer the maximum number of points (524288) using the 

remote commands. It is recommended that the number of decimated points be set to 65536 or 

fewer when using the FETC:MEAS? and FETC:XAXI? commands. For processing larger amounts of 

data, it is preferable to save files using the SYST:SAVE and SYST:SAVT commands, or to use the 

Software Development Kit. 

Prerequisites for Remote Control Setup 

1 Be familiar with the use of TCP/IP or GPIB and the OBR control software before attempting to 

control the OBR remotely. 
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2 Network cabling must comply with IEEE 802 requirements for TCP/IP operation. GPIB network 

must be set up correctly. 

3 Some OBR functions require seconds to complete. Adjust time-outs for your application 

accordingly. 

4 Be aware of the IP address of the OBR PC in order to use TCP/IP remote control. If the remote 

server and client are both on the same PC, the remote client can use the IP address 127.0.0.1 

to refer to its own PC 

Running the Remote Control Server 

The remote server is a separate application from the OBR control software. Exit the main application 

before running the Remote Control Server application.  

When it starts, the Remote Control Server allows the user to select between TCP/IP or GPIB. The 

default setting is to use TCP/IP over port 5000. The selected settings will be retained and set as the 

defaults the next time the program is run. 

The Remote Control software connects to the OBR and waits for a remote client to connect to it. 

Once a remote client connects, the Remote System Connected indicator lights up, and the Activity 

Log shows the commands and responses as they are processed. 
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Figure 5-1 The remote control server software. 



 OBR Users Guide 

68 

 

 

Figure 5-2 The remote control server software with an active connection. 
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Once a connection has been established, the Remote Control Server looks for remote commands 

and processes them sequentially. The results are returned to the remote client and also displayed in 

the Activity Log. Numerical results, such as event information and x- and y-axis data are not 

displayed in full in the Activity Log. Instead, the log will simply read, “<data>”. 

Connecting to the Remote Control Server 

A remote control client can be written in any language that can send TCP/IP packets or can 

communicate over a GPIB connection. The remote client should connect to the selected port on the 

target (or the correct address on the GPIB network) and then send remote commands to the server. 

The OBR software includes two example remote clients (one for TCP/IP and another for GPIB) with 

LabVIEW 2010 source code. Both executable programs are located in the folder C:\Program 

Files\Luna Technologies\OBR 5T50\Remote Client. The LabVIEW source code for both is in the src 

folder in that location. 
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Figure 5-3 Example TCP/IP remote client software. 
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To use the example software, press the Open Connection button to connect to the remote server. 

Then type commands in the Commands box and press the Send Commands button. The commands 

will be sent to the server one at a time, and the results are displayed in the Responses text box. 
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Figure 5-4 Example remote client with active session. 
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Setting up a GPIB network 

A GPIB network consists of at least two GPIB cards (most likely on two separate PCs) connected by 

a GPIB cable. There can be multiple GPIB cards on a network, and each must have a unique 

address. 

One of the GPIB cards on a network is configured to be the System Controller. For best results, this 

should be the GPIB card used by the Remote Control Client software, not the Remote Control 

Server. The assignment of GPIB addresses and System Controller status is done with the GPIB 

configuration software that comes with the GPIB cards, not the Luna Innovations OBR software. For 

National Instruments GPIB cards, this is the NI Measurement and Automation software. 

The Remote Control Server should specify the GPIB card it is using, along with that card’s address.  

The Remote Control Client should specify the GPIB card it is using, along with the target address – 

that is, the address being used by the Remote Control Server. Neither piece of software needs to 

know the Client software’s GPIB address. 

As an example, say a two-card GPIB is set up with the following options. The Client’s GPIB card is 

set to GPIB0 and address 1. It is set as the System Controller. The Server’s GPIB card is set to 

GPIB1 and address 0. In the NI Measurement and Automation software, this configuration looks like 

the following: 
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Figure 5-5 Example remote GPIB configuration. 
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The Remote Control Server will be set to use GPIB1 and address 2, as shown below: 

 

Figure 5-6 Example Remote Server GPIB options. 

 

The Remote Control Client will use GPIB0, and will connect to address 2. 
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Figure 5-7 Example Remote Server GPIB options. 

 

 

Remote Control Commands for the OBR 

This section gives a description of every remote control command available with the OBR remote 

control software. The commands are organized by function. System level commands begin with 

“SYST:”. (The one exception is the SCAN command, which has no prefix.) Configuration commands 

begin with “CONF:”, and commands that retrieve data begin with “FETC:” (for “fetch”). 

Commands that end in a question mark are referred to as queries and return responses. Commands 

without an ending question mark do not retrieve values. The queries SYST:ERR? and SYST:ERRD? 

can be used to determine whether or not these commands were successful. 
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It is important to remember to send the SYST:INIT to initialize the OBR 5T-50 hardware before 

sending commands like SCAN that use the hardware. If the hardware has not been initialized, the 

SYST:ERR? command will return a non-zero response to indicate that the scan has failed, and the 

SYST:ERRD? response will give more information about the error. 

 

Figure 5-8 Error when using SCAN command before SYST:INIT? 

The SYST:RDY? command can be used to query whether the system is ready to perform 

measurements. If this command returns 0, the SYST:INIT command should be sent. If SYST:RDY? 

returns 1, then the system is ready anSd SYST:INIT is not necessary. 
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Figure 5-9 Checking that the system is initialized before using SCAN command 

In the session shown above, SYST:RDY? is used to see if the system is ready for hardware 

operations. It is not (response is 0), so a SYST:INIT command is sent. The *OPC? command is sent 

to see if the operation is complete. Once SYST:INIT has completed, SYST:RDY? is checked again. 

The system is now ready (response is 1), and the SCAN command can be sent and will complete 

without error. 

Some commands have parameters, shown in brackets in this document. Note that for queries, the 

question mark appears after the command name, not after the parameter and the end of the full 

command string. For example, the correct format for the FETC:EVNT? query is “FETC:EVNT? 1”, not 

“FETC:EVNT 1?”. 
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Important 

 

The OBR control software does not support multiple 

commands on a line, separated by semicolons. Enter each 

command on a separate line.  

IEEE 488.2 defines commands as being either sequential or overlapped. Sequential commands 

cause the instrument to ignore other remote control commands until each command has completed. 

Overlapped commands let the device respond to incoming commands before pending commands 

completely execute. The OBR processes only sequential commands. 

All commands are case-sensitive, and must be entered exactly as they appear in this chapter. 

Remote control commands are classified by types: 

 System Control Commands 

 Configuration Commands 

 Data Capture and Retrieval Commands 

System Level Commands 

*IDN? 

Usage:  *IDN? 
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Description: Queries the identity of the device. 

Response:  “OBR 5T-50” and the version number. Ex: “OBR 5T-50 v1.0.0”. 

Note:   This command is not displayed in the Remote Server’s Activity Log. 

*OPC? 

Usage:  *OPC? 

Description: Indicates whether the previous operation has completed. 

Response:  1 if the previous operation is complete, or 0 if it is still being processed. 

 

SYST:INIT 

Usage:  SYST:INIT 

Description: Initializes the OBR for acquiring data. 

Response:  None. 

Note:   This command should be called before acquiring data or changing scan parame- 

   ters. The SYST:INIT command should only be called once at the beginning of a  
   remote session.  

After calling SYST:INIT, poll the *OPC? command and wait until the response is 1 

before sending any other commands. 

 

SYST:VER? 

Usage:  SYST:VER? 
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Description: Returns the software version number. 

Response:  the software version number. Ex: “1.0” 

 

SYST:ON? 

Usage:  SYST:ON? 

Description: Queries whether the OBR is turned on. 

Response:  1 if the OBR is on, or 0 if it is off 

 

SYST:RDY? 

Usage:  SYST:RDY? 

Description: Queries whether the OBR is ready to acquire data. 

Response:  1 if the OBR is ready, or 0 if it is not 

 

SYST:ERR? 

Usage:  SYST:ERR? 

Description: Returns the error status of the previous command. 

Response: 0 if the previous command was successful, or a non-zero error code if the previous 
command failed. 
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Note: If the response is not 0, the SYST:ERRD? query can be used to retrieve a more 

detailed error message. 

 

SYST:ERRD? 

Usage:  SYST:ERRD? 

Description: Returns a detailed error status showing the results of the previous command. 

Response: A string indicating the results of the previous command. 

 Examples: 

“Set the group index to 1.50” 

 “Alignment succeeded” 

 “Failed to write the file C:\My Data\MyFile.txt” 

 

SYST:ALIG 

Usage:  SYST:ALIG 

Description: Aligns the optical network of the OBR  

Response: None. Use SYST:ERR? or SYST:ERRD? to determine if the alignment was 
successful. 

Note: This command cannot be used unattended. The Remote Command Server will 

prompt the user to disconnect any devices from the instrument in order to perform 
the alignment. This command should not be used if there is no operator to 

physically attend to the OBR. 
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SYST:ALIG? 

Usage:  SYST:ALIG? 

Description: Queries whether the OBR optical network is aligned 

Response: 1 if the OBR is aligned, 0 if it is not. 

Note: The alignment check should be performed with no devices connected. For this 

reason, it is preferable not to use this command unattended. 

 

SYST:SAVE 

Usage:  SYST:SAVE { filename } 

   Ex: SYST:SAVE “C:\My Data\MyFile.OBR2” 

Description: Saves the current measurement as a binary file. 

Response: None. Use SYST:ERR? or SYST:ERRD? to determine if the file was saved 

successfully. 

Note: Filename which contain spaces should be contained in quote marks. The 

SYST:SAVE command does not append a file extension, so the “.OBR2” extension 

should be included in the filename parameter. 

SYST:SAVT 

Usage:  SYST:SAVT { filename } 

   Ex: SYST:SAVT “C:\My Data\MyData.txt” 
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Description: Saves the current measurement as a text file. 

Response: None. Use SYST:ERR? or SYST:ERRD? to determine if the file was saved 
successfully. 

Note: Filename which contain spaces should be contained in quote marks. The 

SYST:SAVE command does not append a file extension, so the “.txt” extension 
should be included in the filename parameter. 

 

SYST:SAVN 

Usage:  SYST:SAVN { filename } 

   Ex: SYST:SAVN “C:\My Data\MyEvents.txt” 

Description: Saves the current measurement’s event table as a text file. 

Response: None. Use SYST:ERR? or SYST:ERRD? to determine if the file was saved 
successfully. 

Note: Filename which contain spaces should be contained in quote marks. The 
SYST:SAVE command does not append a file extension, so the “.txt” extension 

should be included in the filename parameter. 

 

 

SCAN  

Usage:  SCAN 

Description: Acquires a new measurement 
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Response: None. Use SYST:ERR? or SYST:ERRD? to determine if the scan was successful. 

Configuration Commands 

Note: The configuration commands affect the setting that will be used for the next scan. None of these commands 

 will take effect until after sending the next SCAN command.  

CONF:GRP? 

Usage:  CONF:GRP? 

Description: Retrieves the current group index. 

Response:  The current group index. 

Ex: 1.468200 

 

CONF:GRP 

Usage:  CONF:GRP { group index } 

Description: Sets the current group index. 

Response:  None. 

 

CONF:DECI? 

Usage:  CONF:DECI? 
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Description: Retrieves the current number of decimated points. 

Response:  The current number of decimated points 

Ex: 4096, 16384, 524288, etc. 

 

CONF:DECI 

Usage:  CONF:DECI { number of decimated points } 

Description: Sets the number of decimated points. 

Response:  None. 

Note: This command controls the number of points that will be returned by the 
FETC:XAXI? and FETC:MEAS? commands, as well as the number of points written 

to the text file using the SYST:SAVT command. It does not affect the amount of 

data written to the binary file using SYST:SAVE; the binary file always contains the 
full measurement data. 

 The number of decimated points is generally a power of two, but this is not strictly 
necessary. The maximum value is 524288 (the full number of points in the OBR 

measurement). Any values larger than this will be ignored. The default value when 

starting the Remote Control Server software is 16384. 

 Note that retrieving large numbers of points using the FETC:XAXI? and 

FETC:MEAS? commands may take a long time. For processing large amounts of 
data, it is preferable to save data files with the SYST:SAVE or SYST:SAVT 

commands, or to use the Software Development Kit. 

 

CONF:XUNI? 
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Usage:  CONF:XUNI? 

Description: Retrieves the current x-axis units. 

Response:  0: nanoseconds, 1: meters, 2: feet, 3: inches, 4: millimeters  

 

CONF:XUNI 

Usage:  CONF:GRP { units } 

   Valid values for the units parameter are: 

0: nanoseconds, 1: meters, 2: feet, 3: inches, 4: millimeters 

Description: Sets the x-axis units. 

Response:  None. 

Note: This sets the units used by the FETC:XAXI? and FETC:EVNT? commands, as well 
as the text files saved by SYST:SAVT and SYST:SAVN. It also controls the units 

that should be used by the commands CONF:RLW, CONF:ILW, CONF:MNEV, and 
CONF:MXEV. 

 

CONF:RLW? 

Usage:  CONF:RLW? 

Description: Retrieves the width used to determine the return loss of events in the event table. 

Response:  Return loss width, in the units specified by the CONF:XUNI command. 
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CONF:RLW 

Usage:  CONF:RLW { return loss width } 

Description: Sets the width used to determine the return loss of events in the event table. 

Response:  None. 

Note: The return loss width parameter must use the units specified by the CONF:XUNI 

command. 

 

CONF:ILW? 

Usage:  CONF:ILW? 

Description: Retrieves the width used to determine the insertion loss of events in the event 

table. 

Response:  Insertion loss width, in the units specified by the CONF:XUNI command. 

 

CONF:ILW 

Usage:  CONF:ILW { insertion loss width } 

Description: Sets the width used to determine the insertion loss of events in the event table. 

Response:  None. 

Note: The insertion loss width parameter must use the units specified by the CONF:XUNI 
command. 
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CONF:MXEV? 

Usage:  CONF:MXEV? 

Description: Retrieves the maximum location for which events will be found. 

Response:  Maximum event location, in the units specified by CONF:XUNI. 

 

CONF:MXEV 

Usage:  CONF:MXEV { maximum event location } 

Description: Sets the maximum location for which events will be found. 

Response: None. 

Note: The minimum location parameter must use the units specified by the CONF:XUNI 
command. 

 

CONF:MNEV? 

Usage:  CONF:MNEV? 

Description: Retrieves the minimum location for which events will be found. 

Response:  Minimum event location, in the units specified by CONF:XUNI.  

 

CONF:MNEV 
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Usage:  CONF:MNEV { minimum event location } 

Description: Sets the minimum location for which events will be found. 

Response:  None. 

Note: The minimum location parameter must use the units specified by the CONF:XUNI 
command. 

 

CONF:NEVT? 

Usage:  CONF:NEVT? 

Description: Retrieves the maximum number of events that will be calculated in the event 
table. 

Response:  Maximum number of events, a value from 0 to 4. 

 

CONF:NEVT 

Usage:  CONF:NEVT { max number of events } 

Description: Sets the maximum number of events that will be calculated in the event table. 

Response: None. 

Note: Valid values for the max number of events parameter are 0 to 4. Values larger 

than 4 will be coerced to 4. 

 

CONF:EVTH? 
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Usage:  CONF:EVTH? 

Description: Retrieves the minimum amplitude (in dB) for which events will be found. 

Response:  Minimum event threshold in dB.  

 

CONF:EVTH 

Usage:  CONF:EVTH { minimum event threshold } 

Description: Sets the minimum amplitude (in dB) for which events will be found. 

Response: None. 

 

CONF:FWIN? 

Usage:  CONF:FWIN? 

Description: Queries whether the frequency domain Hanning window will be applied to the 
measurement data. 

Response:  1 if the window will be applied, 0 if not 

 

CONF:FWIN? 

Usage:  CONF:FWIN { 0 or 1 } 

   1 to apply the window, 0 not to apply it 
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Description: Sets whether the frequency domain Hanning window will be applied to the 

measurement data. 

Response:  None 

Note: The frequency domain window affects the data returned by the FETC:MEAS 

command or saved in the text file by SYST:SAVT. It does not affect the data 
stored in the binary file with SYST:SAVE. The binary file always contains the full, 

original data. 

CONF:ZERO? 

Usage:  CONF:ZERO? 

Description: Retrieves the zero length location. 

Response:  Zero length location, in the units specified by CONF:XUNI 

 

CONF:ZERO 

Usage:  CONF:ZERO { zero length location} 

Description: Sets the zero length location. 

Response:  none 

Note: The zero length location parameter must use the units specified by the CONF:XUNI 
command. 
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Data Retrieval Commands 

FETC:FSIZ? 

Usage:  FETC:FSIZ? 

Description: Retrieves the size of the measurement data. 

Response:  The size of the measurement data. 

Examples: 4096, 16384, etc. 

Note: This indicates the number of points that will be returned by the FETC:XAXI and 

FETC:MEAS commands, as well as the number of points saved in the text file using 
the SYST:SAVT command.  

It should match the number of decimated points returned by the CONF:DECI? 
query. Note, however, that if CONF:DECI is set to 524288 the number of points 

returned by FETC:FSIZ? will be slightly smaller because some points at the 

beginning and end of the measurement are discarded during processing. 

 

FETC:XAXI? 

Usage:  FETC:XAXI? 

Description: Retrieves the x-axis data for the measurement. 

Response:  A series of x-axis points, separated by newline characters. 

Note: The x-axis values will be in the units specified by the CONF:XUNI command. The 
number of points returned is equal to the response of the FETC:FSIZ? command. 
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The points are separated by newline characters and terminated with the string 

“///”. 

 

FETC:MEAS? 

Usage:  FETC:MEAS? 

Description: Retrieves the y-axis amplitude data for the measurement. 

Response:  A series of y-axis points, separated by newline characters. 

Note: The number of points returned is equal to the response of the FETC:FSIZ? 
command. The points are separated by newline characters and terminated with 

the string “///”. 

 

FETC:NEVT? 

Usage:  FETC:NEVT? 

Description: Retrieves the number of events found in the event table. 

Response:  The number of events found. 

Note: This value indicates the number of events that were found using the minimum 

event threshold. It may be smaller than the maximum number of events set with 
the CONF:NEVT command. 

 

FETC:EVNT? 

Usage:  FETC:EVNT? { event number } 
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Description: Retrieves the x-axis location, return loss, and insertion loss for the specified event. 

Response:  The x-axis location, return loss, and insertion loss. 

Note: The event number parameter should be a value between 0 and 3. 0 indicates the 
first event, 1 the second, and so on. 

The x-axis location will be in the units specified by the CONF:XUNI command. Both 

loss values are in units of dB. The three points are separated by newline 
characters and terminated with the string “///”. 

 

FETC:TIMS? 

Usage:  FETC:TIMS? 

Description: Retrieves the measurement’s start time in nanoseconds. 

Response:  The start time in nanoseconds. 

 

FETC:TIME? 

Usage:  FETC:TIME? 

Description: Retrieves the measurement’s end time in nanoseconds. 

Response:  The end time in nanoseconds. 

 

FETC:TINC? 
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Usage:  FETC:TINC? 

Description: Retrieves the measurement’s time increment in nanoseconds. 

Response:  The time increment in nanoseconds.  
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Chapter 6 Measurement Theory  

The Luna OBR utilizes swept-wavelength interferometry to interrogate the device or system under 

test.  This technique measures the full scalar response, including both phase and amplitude 

information. The amplitude of the time domain data is equivalent to a traditional optical time domain 

reflectometry (OTDR) measurement.   

Fiber Optic Interferometry  

The OBR uses swept-wavelength coherent interferometry) to measure the Rayleigh backscatter as a 

function of position in the optical fiber. Rayleigh backscatter in optical fibers is caused by random 

fluctuations in the index profile along the fiber length. Scatter amplitude is a random but static 

property of a given fiber. This technique is presented at an introductory level. For more information 

see the references at the end of this section. 

The two basic types of fiber interferometers are shown in Figure 7-1.   

(1) A Mach-Zehnder design uses one 3 dB coupler to split the light, and another 3 dB coupler to 

recombine the light. In general, the two paths between the couplers are of different lengths. A 

detector is placed at the output of the second coupler.  

(2) A Michelson interferometer uses a single 3 dB coupler to both split and recombine the light. 

Mirrors are placed at each of the outputs on one side of the coupler, and in general the two paths 
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are of different lengths. On the other side of the coupler, one lead is used to inject the light, and the 

other is directed to a detector. 

 

Figure 6-1 Two basic types of fiber interferometers: (a) Mach-Zehnder and (b) Michelson. 

 

Both of these interferometer designs can be treated in a basic way using the same set of 

mathematics. Consider an input field of the form 

, 

where  is angular optical frequency, and  describes the instantaneous frequency of the tunable 

laser source. 

The spatial dependence of the signal may be ignored because the light is detected only at a single 

point. At the first coupler, the input field is split into two fields,  and . After propagating through 

different lengths of fiber, the two fields are recombined, and the resulting field at the detector is 

, 

Ein E0 t e i–  t t=
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where  and  are the delays through the two paths of the interferometer.  

The electrical output of the detector is proportional to the optical intensity, I, which is given by the 

square magnitude of the electric field: 

, 

where the time delay difference between the interferometer paths .  

Optical Network for OBR 

A schematic of Luna’s OBR optical network is shown in Figure 7-2. The optical system is comprised 

of a tunable laser source (TLS), an interferometer (which includes the device under test (DUT)), and 

a detector. 

 

Figure 6-2  OBR optical network 

The basic idea from the previous section can be applied to device characterization by including a 

DUT in one arm of a Mach-Zender interferometer, as shown in Figure 7-2. We can describe the DUT 

by its frequency domain linear transfer function, ; the linear transfer function contains 

1 2

I   E0 t  2 E0 t –  2 2E0 t E0 t –   t  cos+ +=

 1 2–=

H  
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information about the amplitude, , and phase, , response of the DUT and is given by 

. Given the amplitude and phase response, the detected power is proportional to the 

intensity, I, given by 

 

Next a Fourier transform is performed allowing the three terms in the above expression to be 

separated spectrally. Note that the first two terms will have only low frequency characteristics, and 

thus will appear at or near  in the time-domain. The device information resides in the third 

term of this expression, called the interference term. The interference term oscillates at the 

frequency , while the other terms do not oscillate. Its location in the time-domain will be 

determined by the delay difference  between the two arms of the interferometer. Provided that  

is large enough, the device response will be separable from the low frequency terms, and thus 

measurable. The Luna OBR is designed such that the internal delay path through the device under 

test is long enough such that the low frequency terms will not influence the measurement, even for 

very short devices. Thus the OBR operates with no dead zone.  

The Fourier transform of reflected optical intensity (I) for a short length of a single-mode fiber is 

plotted in Figure 7-3 (a). Figure 7-3 (b) shows the selected segment that contains the device 

information. Because the initial data was acquired as a function of optical frequency, ω, the 

transformed data is a function of time. For this reason, the transformed data is referred to as time 

domain data. 

     

H     ei  =
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Figure 6-3  (a) The Fourier transform of interference fringes.  

(b) The segment of the time domain data that contains device information. 

If there are multiple reflecting interfaces within the device under test, each interface will contribute 

a term to the interference pattern and a peak in the time-domain located at the corresponding 

delay. 

In order to more easily locate the source of reflections within a device, the time-domain data can be 

scaled in units of length, using the speed of light and the group index of the DUT. 
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Time Domain Amplitude (dB) 

As mentioned above, the OBR uses coherent interferometry to measure the linear transfer 

function,               , of the DUT. From this, the impulse response is given by the Fourier 

transform of the transfer function, 

               , 

where FFT{H(ω)} denotes the Fast Fourier Transform of H(ω). The index j indicates the location in 

the data array, and corresponds to time. 

The Amplitude (dB) curve is the time domain linear amplitude data plotted on a log scale, according 

to the following relation: 
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Figure 6-4 Time domain Amplitude data for a 0.5m jumper. 

Integration Width 

The Integration Widths area in Tools > Set Preferences controls the length of the segments 

used to calculate the average loss within (Return Loss) and between (Insertion Loss) segments. 

Return Loss and Insertion Loss 

The software automatically identifies up to four (4) reflection events starting from a user-specified 

location along the DUT (Tools > Set Preferences > Events > Minimum Location).  
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The Return Loss as displayed in the Events table is calculated over the Integration Width set in 

Tools > Preferences > Integration Widths > Return Loss. For example, if the entire time 

domain axis is given by         and a reflection peak is bound such that          , then the average 

return loss at that cursor is given by 

             
        

  

       
 

 

where   
  is the impulse response, as defined above. 

The Insertion Loss for any particular reflection, as displayed in the Events table, is simply the 

difference between the return losses on either side of the reflection, divided by two (2).  The loss is 

calculated as five times the log of this ratio because the loss is accumulated twice: once for the light 

to get to the particular segment, and once for it to return from the segment. 

Hanning Window 

Some OBR users have noted that the reflectance peaks from strong reflection events (generally with 

higher than -45 dB return loss) exhibit marked broadening at the base. These side band tails can 

sometimes obscure the peak of a weak reflector very near a strong reflector peak. They can also 

overwhelm the nearby Rayleigh scatter level, making insertion loss measurements near the base of 

the strong reflection peak difficult. Using the Hanning Window option (Tools > Set Preferences 

> Display Options) significantly diminishes reflection peak side band tails. There is no significant 

scan or calculation time penalty associated with selecting this option. 
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The effects of the Hanning Window are illustrated in Figures 7-5 which show the reflection trace of 

a LC/PC connector with a clear plastic cap covering the ferrule. In the left trace, the reflections of 

the end cap surfaces are barely visible above the side band tail of the connector. Applying the 

Hanning Window produces the right trace which suppresses the side band tails and greatly 

enhances the contrast of the much weaker end cap reflections just a few millimeters away from the 

connector. 

  

Figure 6-5 Example traces of a LC/PC connector with a clear plastic cap over the ferrule without (left) and with(right) a Hanning Window 

applied. 

How Hanning Window Affects Measurements 

Return Loss (RL) values may be altered by the Hanning Window if the reflection event being 

measured has significant RL variation in the optical frequency domain. For example, connectors and 
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splices tend to have spectrally flat RL, but fiber Bragg gratings and thin film filters do not. For this 

reason, the Hanning Window should be left off when measuring the RL of gratings and filters. 

Insertion Loss (IL) measurements are made by integrating over the Rayleigh scatter. Since fiber 

Rayleigh scatter is spectrally uniform, the Hanning Window will not significantly alter the measured 

Rayleigh scatter amplitude. 

 

Chapter 7 Maintenance 

Cleaning Connectors 

It is extremely important to clean connectors before attaching optical fibers to the OBR for testing. 

Failure to do so may result in noisy data or damaged equipment. 

Optical fiber connectors on cables should be cleaned before every connection to the OBR. The 

bulkhead connectors on the front panel of the OBR should be cleaned frequently, roughly once every 

25 connections. 

The optical fiber connector cleaner is used for cleaning connectors: 
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Mini foam swabs are used for cleaning the OBR bulkhead connectors: 

 

 

The cleaning supplies used with the OBR are: 

•  CLETOP connector cleaner – P/N F1-6270 

•  CLETOP connector cleaner replacement reel – P/N F1-6271 

•  Mini foam swabs (50/package) – P/N F1-0005 

These supplies can be ordered from: 

FIS Incorporated 

161 Clear Road 

Oriskany, NY 13424 

Web: www.fiberinstrumentsales.com 

E-mail: info@fiberinstrumentsales.com 

http://www.fiberinstrumentsales.com/
mailto:info@fiberinstrumentsales.com
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Important 

 

Use only cleaners approved for use with fiber 

optic bulkheads and fiber connectors. Do not 

use any type of cleaning fluid, cotton swabs, or 

cloths. 

Using unapproved cleaning tools or fluids may 

result in erroneous or noisy data, or may 

damage the fibers and OBR components. 

Cleaning Optical Fiber Connectors 

Important 

 

Optical fiber connectors on devices should be 

cleaned before every connection to the OBR. 
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1  Expose the cleaning tape by pushing down the cover release lever. 

 

  

Cleaning tape cov er closed

cov er release lev er

Cleaning tape cov er open

cleaning tapetape cov er
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The cleaner tape has two cleaning strips: 

 

2  Holding the fiber connector perpendicular to the cleaner tape surface, swipe the tip of the 

connector down the first cleaning strip, then swipe on the second strip. 

 

3  Close the cleaning tape cover before swiping another connector. This advances the cleaning 

tape. 

cleaning strips
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Cleaning Bulkhead Connectors 

Important 

 

The bulkhead connector should be cleaned 

about once every 25 connections. 

 

1. Turn off the OBR.   

2. Make sure that no devices are connected to the OBR. 

3. Open the protective cover.  Gently insert one of the supplied swabs, as shown below. Twist the swab 

in one direction, and then remove. Discard swabs after single use. 

 

Figure 7-1 Remove the protective cap. Gently insert supplied mini swab, rotate in one direction, then remove. 
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Cleaning the Case 

Clean the case by wiping it with a soft cloth 

dampened with water or a mild, non-abrasive 

cleaning fluid such as window cleaner. 

 

Replacing Fuses 

The fuse drawer is located on the power module on the instrument case back panel: 

 

Warning 

 

To avoid the risk of serious injury or death, 

ensure that the power cord is disconnected 

from the instrument when checking or 

replacing fuses. 

 

  

Caution 

 

Do not spray any fluid directly on case 

surfaces. It may seep into the interior of the 

case and damage components. 
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To replace fuses 

 

1  Disconnect the instrument power cord.  

1  Place the blade of a screwdriver or similar tool in the slot at the bottom of the fuse drawer, 

then gently pry the drawer out of the power module. 

 
 

3  Replace fuses with Bussmann AGC-2 type 2A @ 250VAC 1 ¼” x ¼” fast acting (FA) fuses, 

rated FS01008.  
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4  Push the drawer back into the power module until it snaps into place. 

5  Reconnect the power cord. 

Packing and Shipping the OBR 5T-50 

The OBR should only be packed and shipped in its original packing materials. If these have been 

discarded, contact Luna Innovations for packing material. To minimize physical shock during 

shipping, the OBR system should always be shipped via air instead of ground, by a reputable 

shipping service provider. 

Required Packing Materials 

•  OBR Shipping Box(es) (#1) 

•  Desktop PC Box (#2) 

•  PC Monitor Box (#3) 

•  OBR Shipping Foam 

•  PC Monitor Shipping Foam 

•  PC Shipping Foam 

•  OBR Accessory Box 

•  PC Accessory Box 
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•  Sturdy packaging tape to seal the boxes 

Packing Procedure  

1  Check that all materials to be shipped are ready to be packed using the “Components List” 

on page 10-14. 

2  Place the supplied protective cap over the detector port and turn it clockwise until 

tightened.  

3  Obtain an OBR Shipping Box (#1). 

4  Seal the bottom center and edges of the box. 

5  Pack the OBR in the OBR Shipping Box using the original Styrofoam insert on each side of 

the OBR. 

6  Place the OBR Accessory Box on top of the OBR. 

7  Seal the top of the box, taping the center and open edges. 

8  Obtain a Luna Desktop PC Shipping Box (#2), as applicable. 

9  Seal the bottom center and edges of the box. 

10  Pack the PC in the PC Shipping Box using the original Styrofoam inserts on each side of the 

PC. 

11  Pack the PC software, as well as the mouse, keyboard, and PC Power Cord in the PC 

Accessory Box. 
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12  Place the PC Accessory Box on top of the re-packaged PC. 

13  Seal the top of the box, taping the center and open edges. 

14  Obtain a Luna Innovations Monitor Shipping Box (#3), if applicable. Otherwise disregard 

the remaining steps. 

15  Seal the bottom center and edges of the box. 

16  Pack the monitor in the Luna Innovations Monitor Box using the original styrofoam inserts 

on each side of the monitor. The Monitor Box should contain the monitor, the monitor 

software and manuals, the power supply and the power cord. 

17  Seal the top of the box, taping the center and open edges.  
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Chapter 8 Troubleshooting  

This chapter describes how to troubleshoot OBR hardware and software errors.  

If you have problems or error messages not listed here, or if the solutions provided here do not 

resolve a problem, please contact Luna Innovations toll free at (1-866-586-2682) or by e-mail at 

solutions@lunainc.com. 

  

mailto:solutions@lunainc.com
mailto:solutions@lunainc.com
mailto:solutions@lunainc.com
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General Troubleshooting 

The OBR or PC will not power on 

Cause(s) Solution(s) 

The OBR and/or the PC is not plugged 

in or turned on 

The OBR  and the PC require separate 

power cords. Plug in the OBR  and/or the PC. 

Make sure to turn on the OBR  power switch 

on the front of the instrument, and the PC 

according to its instructions. 

Blown fuse. Replace the fuse. For instructions, see 

“Replacing Fuses” in Chapter 8 
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All software controls are disabled or unavailable 

Cause(s) Solution(s) 

The instrument is not properly connected 

to the PC. 

Ensure that the cable connecting the 

instrument to the PC is securely attached. 

The instrument could not be configured 

properly due to a communication error. 

Turn the instrument off and then back on 

again then reboot the PC. Restart the OBR  

control software. 

If the problem persists, reinstall the OBR  

control software from the OBR  software CD. 

The OBR  has not stabilized to room 

temperature. 

Allow time for the entire system to stabilize at 

room temperature before trying to operate.  

Laser overheated because air flow to the 

OBR  is restricted. 

Move the OBR away from objects or surfaces 

that restrict air flow through the fan duct on 

the back of the OBR. 

Laser overheated because of 

excessively high ambient temperature. 

Move the OBR to a cooler environment or 

decrease the ambient temperature to within 

the OBR operating range of 10–35oC. 
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Control software will not load 

Cause(s) Solution(s) 

Generally this occurs when other 

software is installed on the PC. 

Remove any software not originally installed 

on the OBR PC, then restart. 
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Control software seems to lock up 

Cause(s) Solution(s) 

The hardware may have stopped 

responding to the software. 

Exit the software, using the Windows® Task 

Manger if necessary. [Click Ctrl + Alt + Del, 

then click the Task Manger button, then 

select the OBR software, and click End 

Task.] Turn the instrument off and then back 

on again. Restart the OBR control software. 

Multiple Luna Innovations software 

applications are running at the same 

time. 

Ensure that you are only running one control 

software program at a time. Software 

applications cannot share the OBR 

instrument, so running more than one at a 

time will produce undesirable results.  

The PC has entered an unusable state. Turn the instrument off and then back on 

again then reboot the PC. Restart the OBR 

control software. 

If the problem persists, reinstall the OBR 

control software from the OBR software CD. 
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Alignment unsuccessful 

Cause(s) Solution(s) 

Normal alignment procedure 

occasionally fails. 

Retry alignment 

 

OBR will not scan 

Cause(s) Solution(s) 

Optics not aligned. Realign 

The instrument is not properly connected 

to the PC. 

Ensure that the cable connecting the 

instrument to the PC is securely attached. 
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Excessive noise in data 

Cause(s) Solution(s) 

Mechanical vibration. Move or shut down any sources of vibration. 

Isolate the OBR from those sources.  

Loose fiber connection. Tighten or reconnect the fiber connections. 

Dirty fiber or bulkhead connections. Clean all connections. For instructions, see 

“Cleaning Connectors” in Chapter 7 

OBR not aligned. Align the Optics using Tools\Align in the OBR 

Software. 

There is a strong reflection in the optical 

path. 

Check for any breaks in the fiber sensor.  

Patch cable too long Shorten the leads to comply with the length 

limit of the OBR.  

Cracks in bulkhead connector alignment 

sleeve. 

Contact Luna Innovations at 1-866-

LUNAOVA or solutions@lunainc.com for 

service. 
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No data after scan 

Cause(s) Solution(s) 

Incorrect graph range settings. Rescale the plot axes.  

 

Instrument drifts out of Alignment 

Cause(s) Solution(s) 

Temperature changes will cause the 

instrument to drift. 

Tools\Align 
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Errors on Software Startup 
 

Cause(s) Solution(s) 

The PCIe cable connections might be 

loose. 

Check the connections to ensure that the 

cable is connected properly to both the 

instrument and the PC. 

The instrument is not turned on. Ensure that the instrument is plugged into the 

proper type of outlet and turn on the power 

switch. 

The software is in an unknown state. Exit and restart the software. 

The hardware is in an unusable state 

and is not responding to the software. 

Exit the software. Turn the instrument off and 

then back on again. Restart the PC and the 

control software.  

The PCIe cable is faulty. Replace the cable 

Communication Error Turn off computer. 
Turn on OBR 5T-50 
Restart Computer 
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The optics were detected to not be aligned properly 

Cause(s) Solution(s) 

This is just a warning letting the user 

know that the optics are not aligned 

properly. 

Align the optics with Tools\Align 

 

If any error occurs consistently, please contact Luna Innovations toll free at 866-LUNAOVA 

(866-586-2682) or by e-mail at solutions@lunainc.com 

  

mailto:solutions@lunainc.com
mailto:solutions@lunainc.com
mailto:solutions@lunainc.com
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Technical Support 

 

If you have any problems with or questions about the information contained in this document, 

please contact our technical support staff by one of the following methods: 

 

Luna Innovations 

3155 State Street 

Blacksburg, VA 24060 

Main Phone: (540) 961-5190 

Toll-Free Support: 1.866.LUNA OVA (866.586.2682)  

E-mail: solutions@lunainc.com  

www.lunainc.com 

 

  

mailto:support@lunatechnologies.com
http://www.lunatechnologies.com/
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Appendix A Specifications 

Parameter Specification Units 

Electrical 

Input Voltage Range 100-250 VAC 

Input Frequency Range 50-60 Hz 

Operating Power  65 VA 

Optical Output   

Maximum Rated Output Power  9.0 mW 

Internal Laser Module Maximum 

Rated Output Power  

20.0 mW 

Emitted Wavelengths 1510-1570 nm 
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PC I/O 

Input/Output Devices 

• CD drive 

• USB ports 

• Ethernet port 

• Keyboard/Mouse 

• Display 
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Environmental 

Operating Temperature Range1 10-35 ºC 

Storage Temperature Range 0-40 ºC 

Relative Humidity (non-condensing) < 80 % 

Dimensions and Weight (Without PC) 

Weight  (PC not included) 7.7 

17 

kg 

lbs 

Case Size  356 X 318 X 171 

14 X 12.5 X 6.75 

mm 

in 

  

                                                           
 

1
 Performance criteria can only be met if the unit is operated within the proper temperature range indicated. Maintenance of an acceptable internal operating 

temperature depends upon proper equipment ventilation. To ensure proper ventilation, never obstruct enclosure airflow openings. 

For current performance specifications, check our website. 
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Class 1 Laser Product  

The Luna Innovations OBR is a Class 1 Laser Product, which meets the requirements of Class 1 in 

standards IEC 60825-1: 2007, and complies with 21CFR1040.10. 

Maximum rated output power: 9.0 mW 

Internal laser module maximum rated output power: 20.0 mW 

Emitted wavelengths: 1510 to 1570 nm 


